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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-OIO1OO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510J-ALCIO | Industrial PC Platform NY-series IPC

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON I574-E1 Model G3AX-MX2-ECT | 3G3AX-MX2-ECT/RX-ECT Inverter
EtherCAT® Communication Unit
User’s Manual

DT 0O014-E - Power PMAC User’s Manual
DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

f C t. Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON Multifunctional
Compact Inverter MX2 Series EtherCAT Communications Unit model 3G3AX-MX2-ECT
(hereafter referred to as the Slave) using OMRON Programmable Multi-Axis Controller model
CK3E-UOOO/NY510-ALOO (hereafter referred to as the Controller) and EtherCAT, as well
as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Model CK3E-LILI0ON
Controller
OMRON Programmable Multi-Axis Model NY510]-ALICI0O
Controller Industrial Box PC
OMRON Inverter Model 3G3MX2-AC1CIOO-V1
OMRON EtherCAT Communications Unit Model 3G3AX-MX2-ECT

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration

The hardware components to reproduce the connection procedures in this document are as

follows:
Model CK3E-OJOOO

Model 3G3MX2-A2004-V1
Model 3G3AX-MX2-ECT

Windows computer
Power PMAC IDE
Acontis EC-Engineer

—=___ Ethernet EtherCAT
communications communications
Servomotor

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-CO00 Ver. 2.2

Controller
OMRON Inverter Model 3G3MX2-A2004-V1 Ver. 2.0
OMRON Str?iterCAT communications | yj5 el 3G3AX-MX2-ECT Ver. 1.1
OMRON Ethernet cable (with industrial Model XS5W-T421-C0IMO-K

Ethernet connector)
- Windows computer -
DT Power PMAC IDE - Ver. 2.2
Acontis Acontis EC-Engineer - Ver. 2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information

This document describes model CK3E-LICICIC as an example. The same procedures can
apply to model NY510J-ACICIC.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller and the Slave are set to factory

default.

I 6.1. Workflow
Take the following steps to operate the PDO communications via EtherCAT after connecting
the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup Prepare the Controller settings.
v

6.2.1 Creation of a New Project
v

6.2.2 Initial Settings of the Controller
v

6.3 Installation of ESI Files Install the ESI file for the Slave into
v Acontis EC-Engineer.

6.4 EtherCAT Communications Setup Set up EtherCAT communications.
v

6.4.1 Communications Setup for the EtherCAT Master
v

6.4.2 Distributed Clock Setup
v

6.4.3 PDO Map Settings
v

6.4.4 Creation of an EtherCAT Network Configuration

File

v
6.5 Controller Settings Set up the Controller.
v
6.5.1 EtherCAT Network Configuration Settings
v
6.5.2 EtherCAT Communications Check
v
6.5.3 EtherCAT Variables Settings
v
6.5.4 Writing the User Program
v
6.5.5 Project Data Transfer

10



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* |f the dialog for confirming
access rights appears upon
start-up, select starting of
Power PMAC IDE.

4 The Communication screen
appears. Specify the IP
address of the destination

Communication

oz 4|3

Controller and click Connect.

IPAddrezs 192.168.0.200 [=]
Port 22
*
The IP address of the Protocnl SSH
Controller is set to User root
. ., Pazzward S99 99
192.168.0.200" by default. ApplydllCantrols True
* |f necessary, Change the SelectDevice AtStartup True
Windows IP address to
“192.168.0.X". IPAddress
Set [P Address

Connect

[ Lazt Ses=zion I [ Mo Device I

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



5 Power PMAC IDE starts, and is
online to the Controller.

.-‘_ Pawer PMAC Suite (TT9E)
Ighm:mmmmzmmnu Window  belp
R R - A ST R b Debug v AnyCPU

-ty

[ - N—— -
[ YUz =53 PowerPmac (1 TOST.
L] rovierPmac(io Device:)|

23 € Language

Ca Configuration

[ Docurnentation

3 Log

)+ [ PMAC Script Language

E-&-8 88

] ¥ B | powrerPmac{No Device:) Profect froper »
ENEeERE): Eub =l sl L T ia) =
e - | 0 AR B
"1 User Buffer 1 .

18 PowerPMAC Communication Setup

D5z 71 PowerPmac OHFRICHALE LR,

6 From the File menu, select
New then Project.

=

% Power PMAC Suite (Administrator)

Edit View Tools Delta Tau Window Help
New » | 5] Project... Ctrl+Shift+N u
Open | Q| File.. Cerl+N tup _
I Close Project From Existing Code... ’
| 1 | Close Solution
H [l | Save Selected Items  Ctrl+S
I Save Selected Items As...
I i@ | Save All Ctrl+Shift+S
Export Template...
: 0 | Page Setup...
|l & | Print... Ctrl+P
H Recent Files »
I Recent Projects b
[ Exit
7 Enter a project name and
location, and select OK. oy
et T BE
Fowerirec PR At tom ke
it Propect Tvoes
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal pane, type the
$$$*** command to reset the
Controller to factory default.

W power PMAC Suite [

File Edit View Project Build Debug Tools DeltaTau Window Help

@S5 d - x5 | b Debug -

Watch: Online[192.168.0.200:55H] ~ & X || Position: Onli

[l |ECATI0).Enable 1
| Slave_0_6071_0_Targettorque |stdin3:2:ermr.. |

> 1 x pp_disable.

Terminal: Online[192.168.0.200:55H]
Welcome to P i S IE*K
&*h

dis=ab
clear

enabl

|SSS”’| 4

2 From the Tools menu, select
System Setup to start System
Setup.

PowerPMAC System Setup
starts.

= Powper PMAL Saite (Administrator)

Fle Edt  Vew Debug | Took | DelaTau ‘Wndsw  Halp
i G e o
B Termna g Postion [ B Ao

Witk Dl [192 180, 0 000 REEEE

g

On | 8| TeskManager
Sand o d Elnl'ﬂrﬂE 5
| | Tune
r ECATIO|
L . poess..,  Chi-+alt+P

C ECaTjp| S| Aftach fo Froce AN
O [ecam S foonranager.

Exhernal Took. .

Do, .,

PrwarPALL Sysmam Satun + Ordeal 197 16 0 00:05)

Fhase Frrqarey 1000

S Frapumncy 1898

Dt G Hlrdbmar 1M Frmpamrncs

T Chars o P Fomumny O3 it S, Acrmsbor, Sebect o P e o
P ok
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3 From the File menu of
PowerPMAC System Setup,

PowerPMAC System Setup @ Online[192.168.0.200:55H]

select New then Setup. | File | Database
| New 3 Setup I
Add 3
Save Setup
estore Setup
4 Specify Servo Frequency.
Global Clock Setting

Select the Servo Frequency
setting from 4 kHz, 2 kHz, or Phase Frequency 1.000 kHe
1 kHz. . -

Servo Frequency 1000 | kHz

* Servo Frequency is set to
1 kHz for the example in this
document.

Detected Servo Hardware-PWM Frequency

5 Click the Accept button.

e 50, [

Q

i &l
Mew clock  PowerPMAC w’t |

Bores settings  Vake
Servo Period (msec) 1000 1000
FhaseCherServoPeriod 1000 1000
3 capl
HNo Master Gate detected and No - -vz |

ETHERCAT option detected

PowerPMAC can be used asa PCusing | _
‘ software clock. (sys CPUTimerdntr = 1) On|

Accepting the clock issus save and 555

in the terminal window for changes to

take effect Check 'sys. SenvoTime’ to

6 If you have changed the servo
frequency setting, type the save
command in the Terminal pane of
Power PMAC IDE.

When complete, the “Save
Complete” message appears in
the Terminal pane.

Terminal: Online[192.168.0.200:55H] ~ 0 X

|SE'-.I'E
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7 Click Communication Setup on

the toolbar to display the Device
Properties dialog box.

File Edit View Debug Tools Defta Tau Window Help
._ﬂ- -

- - 1 Il
ina| B Postion. I Watch I Status i Jog Riffan || Communication Setup|
|\\‘anch ffine 0% = . dazisaxsiio-5 ~ 04X

Eond ey i e Progrertios - ﬁL
] e
P00
s vice
i
o

)

w HHTOERS):

o] In the Device Properties dialog

box, select No Device for IP
Address, then click the Apply
button.

This operation sets the Controller
to the offline state.

B2 Device Properties‘ - ﬂ

’ Test ] [ Applky ]

24l |E
El Device -
Parthumber ‘E ‘
Protocol 55H —

Uzer root

IP Address
Set IP Address

The Controller restarts.

The servo frequency that has
been set is reflected.

10

Wait until the startup process of
the Controller is complete. Then
click Communication Setup on
the toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the Controller
to the online state.

rE Device PrupertiesA =)

L | e

192.168.0.200
PortNumber

Protocol 55H
Uzer root

IPAddress
Set IP Address

]

4 [am |

15



I 6.3. Installation of ESI Files

Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer.

£ Power PMAC IDE
\ﬁl

| Windows Explorer

=13

‘ ‘ #‘ EC-Engineer

_ I

|__'_.c’_f,:' Paint

» Al Programs

| | Search programs and files 2 |

16



2 From the File menu of EC-Engineer,
select ESI Manager.

The ESI Manager appears.

—

I = EC-Enginesr i—ﬁi
m View Network Settings Help

% New Ctri+N
= Open Ctrl+0
H save Cirl+5 _
H saveas
Print

ESI Manager

e ey
= Recent Projects 3
Exit Alt+F4

Example of the ESI Manager

= Esl Manager .~ [E=SEE =)

ESI Files
Select an ESI file which should be deleted o exported or sdd nw ES1 files,
F O Baumueler Nusmberg GrmbH
» Bl Becknolf Automation GmbH & Co. KO
| » € Copiey Controls Corp
| » L e
b B OMRON Corporation
Bouns VIPA Genbed
»

¥ vasuawa Dedtric Conporatian

Number of ESI files: 79
l Number of devices: 1630 .

Add File Add Folder Close

3 Confirm that Omron
3G3AX-MX2-ECT.xml is registered in
the ESI file list of ESI Manager.

If it is not yet registered, click Add File
and register Omron
3G3AX-MX2-ECT.xml.

E——

EST Fles
Select an E51 file which should be deleted or exported or add new E5I files.

I b G Couley Contruis Com.

b Gmron Gx-Digital 10 xmi

Number of devices: 1925 |

Add File Add Felder

= Add ESI File

@@- M < Docimente iy ] SyemESles

I

QOrganize v New folder ER

0 @

Documents library
SystemEsiFiles

¢ Favorites
Ml Desktop
18 Downloads

=

Arrange by:  Folder =

=
1
lIReel Bl = Omron 3G3AX-MX2-ECT

——
1= Omron 3G3AX-RX-ECT

(e Libraries [ Omron CAW-ECTxx

5] pocuments [=] Omron EBNW-ECT
o Music [=] Omron B3X-ECT
) Pictures || Omron FH-eooeo
8 videos = Omron FQ-MS12x-x-ECT
8 Comnuter [ ) I

3

File pame:  Omron 3G3AX-MX2-ECT

~ | ESI Files ("xml} v

4 Click Close to close the ESI Manager.
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I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with slave
devices using an Ethernet cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of
EC-Engineer, and select Lo

Gettings  Help

B Digriosis Mode

EtherCAT Master Unit (Class A) e o
from Add Master Unit. TR

EC = Engineer

Getting Started

= [therCAT Maste:

|| Classic view | Flat View | Topology View

3 Class-A Master is added to the
Project Explorer.

General

it Mame Class.A Master
Cyde Time [us) 1000
‘Source MAC address

18



In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

Devica Editor
Master

General

it Mam: TR YT
Cycle Time [us] 1000 I

Source MAC address

Slaves connected to local system

Petwork Adaptes DO—70L TU P ( Intel(R) Ethernet Connection 1217.LM )

Salect
Slaves connected to remaote system
IP Address 192.168. © 200
Port 6000
Mastir [nstance o Sedoct

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

In the Master page, enter the IP
address of the Controller in IP
Address, and click the Select
button to apply the setting.

* Default IP address
“192.168.0.200" is specified in
this example.

* Do not select Slaves
connected to local system as it
is not used.

Device Editor
Master

General
unit Name Class-A Magter
Cyelie Tirne [ug] 1000

Source MAC address

Slaves connected to local system

Plebworic Adapter O—717 TU P ( Intel(R) Ethernet Connection 1217:LM )

I 17 Adddness 192.168. © 200 I

-

Master-Instance o

Select

Right-click on Class-A Master in
the Project Explorer, and select
Scan EtherCAT Network from
the menu.

= EC-Engineer [--]

File View MNetwork Settings Help

¢ Configuration Mode ™|

Project Explorer Device Editor
. Class-A Master Master

“.. Scan EtherCAT Network

B Diagnosis Mode

dp Append Slave General
Unit Name

% Remove Master-Unit Cycle Time
Source MAC

Slaves conne

= Import Slaves from ENI File Natwork Ad

# Change Master Unit

19



7 Make sure that the Slave IS = EC-Engineer [C:¥Users¥010070239¥Documents¥Po

displayed in the Project Explorer. Fle View Network Settings Help
4 Configuration Mode| |l Export ENI -]
Project Explorer
* . Class-A Master

& Slave_1001 [3G3AX-MX2-ECT] (1001)

6.4.2. Distributed Clock Setup

1 Inthe Project Explorer, select the [ ecengneeri-1 I ——— -
. File View Network Settings Help
targEt SIave to dlsplay the ~{ Configuration Mode ™ =GlLld=s B Diagnosis Mode
Advanced Options tab page. O

- . Class-A Master

Device Editor

‘General H PDO Mapping H Varig

bles | Advanced Options | In Cummands"

| & Slave_1001 [3G3AX-MX2-ECT] (1001) \

Overwrite Watchdog
Set Multiplier (Reg.: 0x400): | 2408
Set PDI Watchdog (Reg.: 0x410):| 1000 (100.000 ms)
| Set 5M Watchdog (Reg.: 0x420): | 1000053 (1000.000 ms)
| Distributed Clocks

[] Potential Reference Clock

* |f the Advanced Options tab page does not appeatr,
select View then the Expert Mode check box.
= EC-Engineer [--]

File Network  Setting

& ¢ Messages
Short Info

Proje
- Expert Mode

Refrash F5
2 In the Advanced Options tab [ ecengincer -1 — -
. Eile View Network Settings Help
page, clear the Potential EE—— R
Reference Clock check box. E e

- L Class-A Master

‘ General H PDO Mapping H Variables | Advanced Options | Init Cummands"
| & Slave_1001 [3G3AX-MX2-ECT] (1001) \

Overwrite Watchdog

Set Multiplier (Reg.: 0x400): | 24085
Set PDT Watchdog (Reg.: 0x410):| 1000 (100.000 ms)
I Set M Watchdog (Reg.: 0x420): | 100005 (1000.000 ms)
| Distributed Clocks

[] Potential Reference Clock

@ Additional Information

Multifunctional Compact Inverter MX2 Series EtherCAT Communications Unit model
3G3AX-MX2-ECT does not support DC mode.

Disable the reference clock by taking the steps shown above.

20



6.4.3. PDO Map Settings

. = EC-Enginser [C:6L AT C 2-ECTHTESTR-3- Liproject ect L ..
1 !Inthe Project Explorer, select e e
. | Configuration Mode| | Export ENI Diagnosis Mode
the target slave to display the S - -

Generd varicbies | Advanced Options | Init Commonds | CoE Gbject-Dictiona

PDO Mapping tab page. oo e ] ot L

257eh tranemi POO Maoping (exiuded by 01801} 01800

7 258t vansmt POC Magping w101

16
1B
E s
15t transmiz PDO Mapping OXZMQ‘
2nd tranamit POO Mapoing eag |
310 trnsmi P00 Magping xiacz i
4h rangmE POO Magging oaaans |
Sth transmiz POC Mapping ia0d i

Classic View | Fiat View | Topology View

2 Check the Inputs field to make
Inputs 0
sure that Only the 258th . Z57th transmit PDO Maoping (exciuded by Tx1BO1) Tx1BO0
transmit PDO Mapping B Lengen
0x1B01 check box is selected. s 3

¥ 258th transmit PDO Magping xiB01
* |f you want to use other data, o] et
. Status OuS100-00 16
clear the currently displayed RS I TP i
check boxes and select other 512th transmit PDO Maoping ot |
desired check boxes.
SYRTC Errer STANLE T2002:01 -3 |
1z trenemit PDO Mapoing G:;ﬁﬁ.’»i
2red trarsmit POO Mapoing Oxiad1 I
3rg transmiz POO Manging oeranz |
AEN TransmE PDO Manging oxtaos |
Sth transmiz PDO Mapoing Cre A0
3 Check the Outputs field to make  outpus
sure that Only the 258th recelve 257tn receive PDO Mapping (emciuded by Dxi701) Dl 700
PDO Mapping 0x1701 check o
box is selected.
J| 258 recene PDO Magsing Gi70L
* |f you want to use other data, Command BxE000:00 1
clear the currently displayed gt S 2
1t receive PDO Mapping D=1 600
check boxes and select other . _ et
2nd recetse FDO Magping Gl
desired check boxes. 3rd rective PO Maoping Di602
4t reseive PDO Mapoing D=i603
Eth recenss POO Mapping Ot Bg
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6.4.4. Creation of an EtherCAT Network Configuration File

Click Export ENI on the upper
1
part of the EC-Engineer page.

= EC-Engineer [--]

File View MNetwork Settings Help

" Configuration Mode

= Export ENI B Diagnosis Made

2 Enter a file name, and then click
Save to create an EtherCAT
network configuration file.

= Export EtherCAT-Network-Information (ENI) File
—

.+ Computer » Local Disk (C:) » tmp

(<IN

Organize =

New folder = o @
& Local Disk (G}~ Name
. DeltaTau
.. inetpub
. Intel ‘
. OE-Downloade—
. Omron
I\ Perflogs

~. Program Files

Date modified Type

Mo items match your search.

.. Program Files

i tmp v 4 M 3
.
I File name: m I -
Shve as type: lEtharCAT-Network-lnformation (ENI) Files (*xml) vl
' Hide Folders [ save | Cancel |

I 6.5. Controller Settings

6.5.1. EtherCAT Network Configuration Settings

1 From the Tools menu of Power e T s
PMAC IDE, select System CRe
. T Hardmarn Dispresss: ——
Setup to display System Setup. || & i EtherCAT.
EtherCAT License Status: EtherCAT 10 Deices Liconss Only
EtherCAT Master ype: ACONTIS
Browse i oni fl |Browse | | Duwnicad Eiie
PowerPMAC System Setup : Ondned 192.168.0,200:55H] T B il

2 Click Browse, and load the
EtherCAT network configuration
file created in 6.4.4 Creation of
an EtherCAT Network
Configuration File.

| File Database

=AY Powss PMAC (1521680200
T Hardmarn Dispross:

L oo EtherCAT. ™
R o] Mt (0] Deactivated]

ETherCAT License Status: EtherCAT 10 Deices Licenss Only
EtherCAT Master type: ACONTIS

Browse to eni fils

3 Click Download ENI file to

download the EtherCAT network

configuration to the Controller.

—
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master ype: ACONTIS

Browse 1o eni file
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6.5.2. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

|ECAT[IJ].EnabIe=1

2 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] - I %
make sure that the ECAT[0].Enable Send g;mand Command Response
value turns to 1. S teaae P
ECATI0].Enable 1
* The OP mode is entered and ECATI0). Error $0
EtherCAT communications are L
established.
3 After making sure that correct Watch: Online[192.168.0.200:55H] -1 x
communications are available, run Send g:mand Command T
the ECAT[0].Enable=0 command o e
from the Terminal pane to stop ECATIO] Enable 1
EtherCAT communications. ECATIO] Errar 50
L]

| Terminal: Online[192.168.0.200:55H]

terminal

rmunicatio
owerPMAC at 192.168

|ECAT[D].EnabIe=EI

4 In the Terminal or Watch pane,
make sure that the ECAT[0].Enable
value turns to 0.

- 0 X

‘Watch: Onling[192.168.0.200:55H]
Send & Command Responze
Demand
Sys SenaConnt 1852214
ECAT[0].Enable o
ECAT[O].Error 50
L]

23



6.5.3. EtherCAT Variables Settings

1 In the System Setup page,
right-click on
Master[0].Deactivated to display
the pop-up menu, and select
Export EtherCAT Variables.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File  Database
=) f;‘ Power PMAC (192 168.0.201

_

EtherCAT.
L

rt EtherCAT Variables —————

TOTETGT CICETTS e TS LtI]ErCAT 10 Device

EtherCAT Master type: ACONTIS

2 Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

.
. Save As

'@©= <« My Documents b Suite b » » v [ 49 il Sear
~ . - ——

Organize = New folder
d Favorites Name Date modified Type Size
B Deskiop ! Bin 7/8/2016 842 PM  File folder
& Downloads C Language 7/8/2016 8:42 PM File folder
%] Recent Places | Configuration 7/8/2016842PM  File folder
Documentation 7/8/2016 8:42 PM File folder
9 Libraries L Log 7/8/2016 8:42 PM File folder
% Documents PMAC Script Language 7/8/20168:42PM  File folder
& Music
&) Pictures
BE Videos
8 Computer -
&, Local Disk (C)
File name:  ECAT Variables| =
S e -]

3 The created EtherCAT variable
definition file is added to under
Global Includes of PMAC Script
Language in Solution Explorer.

Position: Online[19.

Velocity: Onling[192.... v & X || Following Error: Onli...

4 % Solution Explorer - Solution ... » & X

mu [N

[ Solution 'PowerPmac?' (L project)
- ] PowerPmac2(192.168.0.200:x€
3 C Language

[ Configuration

[ Decumentation

[ log

e R R

ecat variablesh ecat_variables.pmh

- Lz PMAC Script Language

& [ Global Includes
#define Slave 0 3220_1 OutputBit00 ECAT[0].IO[0].Data - ]
$define Slave 0 3220 2 OutputBit0l ECAT[0].IO[1].Data
#define Slave 0 _3220_3 OutputBit02 ECAT[0].IO[2].Data
#define Slave 0 _3220_4 OutputBit03 ECAT[0].IO[3].Data
#define Slave 0 3220 5 OutpucBit04 ECAT[0].IO[4].Data 3 Motien Pregrams
#define Slave_0_3220_6_OutputBit05 ECAT[0].IO[S].Data (3 PLC Programs.
#define Slave 0 3220 7 OutpucBit0é ECAT[0].IO[6].Data G v

[ Kinematic Routines
3 Libraries

|
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6.5.4. Writing the User Program

Create programs to be used to check operations.

A specific language is used for the operation check programs. Refer to Power PMAC User’s

Manual and Power PMAC Software Reference Manual for details.

1 In the Solution Explorer pane,

open Project name — PMAC
Script Language — PLC
Programs —plcl.plc.

myecatolp ecatativatelcly | 21510080 | 20051008 pmb

F 0 Terminal
Exaio o Lkt

PE_custom_iaetpl
M pp_sablera
] pp_inc_disabletd

5] pp_inc_startup.bd

5 pp_startup.ba
3 Documentation
a Loy
o PMAC Senpt Lanvguage
2 Global Inchades
MHLSL0EE prby
ekl defindignt prh
A Kinematic Routines
.  Lewnes
W 23 Motion Programs

Propertiet - 3

" ||| ecatscthvatelloly Fie Properties

w7 (A1

x

In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This sample program rotates
the motor by switching the
frequency and rotation direction
of the 3G3AX-MX2-ECT motor
with the interval of 3 seconds.

* In this example, PDO
mapping is assumed to be the
default setting. If you want to
change PDO mapping, rewrite
the “Slave_0....” description.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;
if (P1001 > 2000){

P1001=0;

}
P1001 = P1001+100;
if(P1002==0){
P1002=$0081;
lelse if(P1002==$0081){
P1002=$0082;
telsef
P1002=$0081;

}
Slave_0_5010_0_Frequencyreferenc =P1001;

Slave_0 5000 _0 Command = P1002;

P1000=Sys.Time+(P1001/500)+3;
while(P1000>Sys.Time){};
close
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3 Setting the start of the user -

program ndow  Help
thug = Any CFU - | [ 1800 e ey % N Terminal
o Onl a Sohstion Brpledrer - Sohtion™_ = 3 X
In the Solution Explorer pane,
open Project name —

Configuration —

o Inchade
20150028k
PP progh
i Lsbwmries
¥ [ Resitene Eoutices

& Configueation

prodisable.txt | myecatcfg | ecatactvated.clg | 200500080 W%

pp—dlsabletxt Tk A /f¥ill all the motora (This cprior] '_“!".I'M_rc'd'—'

& [ Documentation

l leg

pp disable twt Fle Propeties
sl

4 In the programming area of the
pp_disable.txt tab page, add enable plc 1;
the program shown on the right
to the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

6.5.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.

26



1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

*+ Power PMAC Suite (Administrator)

File Edit View Project Build Debug Tools DeltaTau V

G- - SHd| s RB|9-0-5-5

hooar |EEE|E SO 103 & B
B Terminal 4 Position [Zf Watch [ Status il Jog Ribbon | 4 ¢
Watch: Online[192.168.0.200:55H] ~ 1 x
Send el Command Responze
Demand
=1 || |ecaTioiEnable o

#1- Make sure that ECAT[0].Enable=0

Terminal: Online[192.168.0.200:55H]

2 Downloading a project

Right-click the project name in the
Solution Explorer pane on the
upper right of the IDE screen, and
select Build and Download All
Programs to run the build and
download.

Solution Explorer - Powe... » O X

|
[ Solution 'PowerPmac_ECC201+5
5o
= &= C Language ; Build
- [ Background B

+ [ Configuration
+-- 3 Documentation
+ 3 Log

+- [ PMAC Seript Lan 4 | cut

Map PMAC Variables
Add Macro Project

X | Remove
Unload Project

< LLI] i | Properties

Clean
- [ CPLCs
- 3 Include Debug
- [ Libraries Build and Download All Programs
#- [ Realtime Rol Download All Programs

Properties ~ I'X ] r

3 Make sure that there are no
errors in the Output tab page.

* |f the transfer fails, check details

of the error in the Output tab
page.

If the error is a program error, you

must review the program.

If the error is related to EtherCAT
settings, return to System Setup
and check whether there are any
incorrect settings.
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4 The program starts running when

it has been downloaded Terminal: Online[192.168.0.200:55H] ~ 0 X
successfully.

EtherCAT communications are in
the OP state.
Make sure that the motor rotates.

|enable plc1

* If the motor does not rotate,
check that the ECAT[0].Enable
value is 1 in the Terminal or
Watch pane.

If the value is 0, run the following
command from the Terminal
pane.

enable plc 1

After you have confirmed an
appropriate operation, save the Terminal: Online[192.168.0.200:55H] ~ 0 X
project to the Controller. Save Complete

Run the save command from the

Terminal pane.

* The transferred project is not
yet saved to the Controller at this
stage.

If you turn OFF the power to the
Controller, the transferred project
will be discarded.
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

o pp_praj.h

----- 1 Libraries

[+~ [d Realtime Routines
Create a Configuration File to save (SRR Configuratios

T | A | 7| ecatag Add b

parameters you have changed in System || = . EESET I —
Setup to the project. || 7 5 P04 _

- |E]| pp_dis Upload Config Files

— pp_!nc Download Config Files

Right-click Configuration in the Solution || | . ¥ Generate Configuration File

Explorer pane, and select Generate e
- [ Documentation

Configuration File. e P e

A Configuration File is added to

Configuration.

2 Right-click on the Configuration File, and = Configuration
from the menu, select Check To _ P
Download Config File to include it in files .. B Open With..
to be downloaded. - A5
3

m

View Code

Exclude From Project
""" }( Delete

Rename
Check To Download Config File

i | Properties

3 Saving a Project % Power PMAC Suite
[ File | Edit  view
. Mew
In the File menu, run Save All to save the open
project on the computer. Add

1 | Close Solution
Upload Project
|l | Save uPowerF

Save uPowerF

i@ Save Al
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

>~ 0 X

Terminal: Online[192.168.0.200:55H]

BL G

3 In the File menu, Click Open —

“ Power PMAC Suite (Administrator)

PrOjeCt/SOIUtion tO |Oad the Edit View Tools Delta Tau Window Help
. New » t - - Debug vHAry CPU v‘ .7
project that you saved. E - . .
pen 3 @] Project/Solution...  Ctrl+Shift+0 -
5 | File... Ctrl+0 I X || velodity:
Response :?
- 0177640 #3
e s #
gl saveall Ctrl+Shift+5 _ #5
I Export Template ) £9
Page Setup
Print +P
Recent Files 4
Recent Projects »
Exit
4 From the Tools menu Of Power PowerPMAC System Setup : Ondne{192.168.0,200:55M] o | i
File Database
PMAC IDE, select System Setup —
] EtherCAT. ™
to dlsplay SyStem Setup' EMhGrCAT Licanse Status: EtherCAT 1D Dewices Liconse Onky
EtherCAT Master ype: ACONTIS
Browse to eni fils Browse Duwnivad ENI te
5 Click Browse, and load the ENI —
EtherCAT. ~

configuration file that you created
in 6.4.4 Creation of an EtherCAT
Network Configuration File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

| Download ENI file |

6 Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

——
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

B‘m
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7 Right-click Configuration in the S ——

Solution Explorer pane, and S
) ) = [ Include -
select Download Config Files to - [ 20160204.h
download the file to the Controller. - LI pp_projh
----- 1 Libraries

+-- [ Realtime Routines
=Rlf=] Configuration

----- | | ecatactiva Add »
|| myecat.cf] !

..... op._custon = | Properties

..... [ ] pp_custon Upload Config Files

- 5] pp_disable Download Config Files

) ? pp_inc_dis Generate Configuration File

- & pp_inc_sta.

----- | pp_save.cfg

]

- 2] pp_startup.ixt 18

8 Right-click the project name in the | Solution Explorer - Powe... » I X

Solution Explorer pane, and =
. [ Solution 'PowerPmac_ECC201+S

select Build and Download All 2B PowerPmac_ECC201+Safe

Programs to run the build and 7 & Clanguage st
- 3 Background H Closn

download.
) Debug 4
- [ Libraries Build and Download All Programs

When the download process is . @ [ Realtime Rof
+1- [3 Configuration
complete, make sure that there 4 02 Documentation

are no errors in the Output tab 4 [ Log hod eero Froect
+- [ PMAC Script Lan # | Cut

Download All Programs

Map PMAC Variables

age.
bag X | Remove
Unlead Project
1 L1 i | Properties
Properties - 1IX l r
Stopping a program Terminal: Online[192.168.0.200:55H] ~ 1 X

If a program is running, execute
the following command from the

] |c|isable ple 1
Terminal pane to stop the
program.
disable plc 1 Terminal: Online[192.168.0.200:55H] + 1 X

ECAT[0].Enable=0

“ECAT[D].EnabIe=EI
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10

Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

}SEVE

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$3$

Terminal: Online[192.168.0.200:55H]

usss
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

549 PowerPMAC (192.168.0.200)
¢ s Hardware Diagnosis

4 Motors

YY) ctcr{0] Activated

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

C\U=sers\OMRON_IPC_1\Desktopleni.xm!

[Browse| [ Download ENIfile
STave status
ECAT[®].5laveCount=2 B Mo Status Emor  Description
ECAT[@].TxTime=3
ECAT[®].RxTime=1 0 o] Mo Slave_1001 [GX0D1611]
BERE L= D e 1 oP No | Slave_1002 [GX-MD3218]

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

|| File

View

Network

#. Configuration Made

Settings

m

Help

[ Diagnosis Mode

Project Explorer
v @ Class-A Master <connected>
| o Slave 1001 [GX-0D1611] (1001) |
@ Slave_1002 [GX-MD3218] (1002)

Device Editor
General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]

State Machine

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

-

= Network Mismatch Analyzer

m@ﬂ

List of slaves

Name Configured Slave
Slave_002 [R3& | R88D-KNO1L-ECT [2]

Slave_003 [R8S | RESD-KND1L-ECT [3]

0x00020001 0

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Revision Alias | Network Slave

0x00020001 | O

Revision Alias

REBD-KNO1L-ECT [2] | 0x00020001 | 1

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status: Online[192.168.0.

Motor Status ] Coordinate Status

Global Status

Description

BufSizeErr
ConfigloadErr
Default
FileConfigErr
FlashSizeErr

Status

AbortAll False

False
False
False
False
False

MACRO 5tatus ] ECAT Status ]

Description
HWCha-ngeErr
MoClocks
ProjectLoadErr
PwrOnFault
WD TFault

Status
| i:alse
False
False
False
MNoFault
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATIi].Error

ECAT]Ii].LinkUp
ECAT[i].LPDomainOutputState
ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/0O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable
(2 and 3 are not supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content
code
A May 18, 2016 First edition
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